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PREFACE
This user’s manual accompanies version 6.0 of The Management Scientist, a personal computer software 
package developed by David R. Anderson, Dennis J. Sweeney, and Thomas A. Williams. The software, 
developed to assist students enrolled in quantitative methods and management science courses, can be 
used to solve a wide variety of textbook problems as well as small-scale problems encountered in 
practice. Use of The Management Scientist demonstrates the valuable role of the computer in applying 
quantitative methods to decision problems.

The new version 6.0, available for Windows 2000 and Windows XP operating systems, has a 
significantly improved user interface.*

We take this opportunity to acknowledge the major contribution made by Amy Anneken in the 
development of Versions 4.0 through 6.0. Also, we are indebted to Daniel Joseph and Bradley Beck who 
assisted with previous versions of the software. At this time we do not know of errors but, of course, take 
responsibility for any that remain.

If you have any comments and suggestions regarding The Management Scientist software, we 
welcome your input. Please send comments and suggestions to

Dr. Dennis J. Sweeney
Dennis.Sweeney@uc.edu

David R. Anderson
Dennis J. Sweeney
Thomas A. Williams

*Version 6.0 has been designed to run optimally on computers with screen resolutions of 1024 x 768 or 
higher. Computers with lower screen resolutions can still run Version 6.0. Scroll bars will appear when 
necessary for working with large problems.
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CHAPTER 1

INTRODUCTION

Welcome to version 6.0 of The Management Scientist. You are ready to install and begin using a PC 
software package designed to solve the following quantitative models for managerial decision making:

Linear programming
Transportation
Assignment
Integer linear programming
Shortest route
Minimal spanning tree
PERT/CPM
Inventory
Waiting lines
Decision analysis
Forecasting
Markov processes

You do not have to be an expert in quantitative analysis to use this software package. If you have a 
general understanding of the above types of problems, you simply select the program module that is 
appropriate for the problem you wish to solve. The corresponding chapter in this manual will guide you 
through an example problem and familiarize you with the data input, special features, and output 
information provided by the module. After following the step-by-step procedure for the example problem, 
you should be able to input, solve, and interpret the results for other problems that use that module.

1.1  USING THIS MANUAL

Most of us, after obtaining a new software package, would like to begin solving problems immediately; 
we do not want to read the complete manual just to get ready to use the software. The manual for The 
Management Scientist was prepared with this thought in mind. We recommend taking the following steps 
to minimize the start-up effort and thus be able to begin using the software as soon as possible.

1. Follow the directions in Section 1.2 to install The Management Scientist on a personal 
computer using Windows NT, Windows 2000, or Windows XP.
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2. Continue to read, or at least skim, the rest of Chapter 1 to obtain an overview of the entire 
software package and most of its features.

3. Select any one of the 12 modules of The Management Scientist to try. The chapters of the 
manual are independent of each other, so you should have no difficulty going directly to 
Chapter 9 if, for example, you want to use the inventory module first or going directly to 
Chapter 4 if you would like to try the assignment module. The discussion describing the module 
introduces you to the type of problems that can be solved and then shows you how to create and 
solve an example problem.

1.2  INSTALLATION

Version 6.0 of The Management Scientist will run on personal computers running Windows 2000 and 
later versions of Windows up through Windows XP. Installing the software on your computer is easy. 
Install The Management Scientist as follows:

1. Place the disk in the CD-ROM drive.

2. In Windows from the Start taskbar, choose Run.

3. On the Command line, type D:\ Setup. If your CD-ROM drive is not D:, substitute the 
appropriate letter.

4. Click the OK button or press the Enter key.

5. Follow the prompts of the installation.

Running The Management Scientist

Once The Management Scientist has been installed it is ready to be used. To run MS 6.0 after it has been 
installed, go to Programs from the Start button. Go to The Management Scientist group and click on The 
Management Scientist, or its logo. The opening screen will then appear. Just click Continue to begin 
working with one of the 12 modules.

1.3  OVERVIEW OF THE SOFTWARE PACKAGE

The Management Scientist software package consists of 12 computer programs, called modules, that use 
quantitative methods to develop decision-making information. A brief description of each of the modules 
including problem-size information is provided below. More detailed information about each of the 
modules is presented in the remaining chapters.

Modules Available in The Management Scientist

Linear Programming. This program will maximize or minimize the value of a linear objective function 
subject to a set of linear constraints. The program can handle up to 100 variables and up to 50 
constraints. Sensitivity analysis information is provided.
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Transportation. This program will find the minimum cost or maximum profit schedule for the 
transportation of units from several supply origins to several demand destinations. Transportation 
problems with up to 30 origins and up to 30 destinations are permitted.

Assignment. This program will minimize the cost or maximize the revenue associated with assigning a 
set of agents to a set of tasks. Assignment problems with up to 30 agents and up to 30 tasks are 
permitted.

Integer Linear Programming. This program will solve all integer and mixed integer programming 
problems with up to 100 variables and 50 constraints. Both general integer and 0–1 variable problems 
can be solved. Data input and editing features are the same as for the linear programming module. 
Large numbers of integer variables significantly increase solution time.

Shortest Route. This program will find the shortest route between any two nodes of a network. Any node 
may be selected as the starting node and any other node may be selected as the ending node. The 
program will handle networks with a maximum of 20 nodes and a maximum of 40 arcs.

Minimal Spanning Tree. This program will find the minimal spanning tree for a network that has a 
maximum of 20 nodes and a maximum of 40 arcs.

PERT/CPM. This program will develop activity schedules for projects with up to 25 activities. Both the 
cases of certain activity times (single activity time estimates) and uncertain activity times (three activity 
time estimates) are allowed. The activity schedule, the critical activities, and the expected project 
completion time are computed.

Inventory. This program provides six inventory models that can be used to determine 
the optimal order quantity, the optimal reorder point, and related operating policies for a 
variety of inventory situations. Both the cases of deterministic demand and probabilistic demand are 
permitted.

Waiting Lines. This program will provide a summary of the operating characteristics of 
a variety of waiting line systems involving single and multiple channels. Operating characteristics such 
as average waiting time, average number of units in the system, probability of waiting, and so on are 
provided. An economic analysis of the waiting line may be conducted.

Decision Analysis. This program will provide the best decision alternative recommendation for problems 
having up to 10 decision alternatives, up to 10 states of nature and known or unknown state of nature 
probabilities. Up to 10 indicators (sample outcomes) may be considered in order to develop a decision 
strategy based on sample information. The expected values of perfect information and sample 
information are provided.

Forecasting. This program will compute forecasts for a time series by using either moving averages, 
exponential smoothing, trend projection, or trend and seasonal components. The mean square error 
measure of forecasting accuracy and forecasts for future time periods are provided. Time series with up 
to 100 data values or observations are permitted.
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Markov Processes. This program will analyze Markov processes with up to 10 states. Both Markov 
processes involving steady state behavior and absorbing states can be analyzed.

1.4  USING THE MANAGEMENT SCIENTIST

This section describes the features of The Management Scientist that are found in all 12 modules. An 
overview of this section is recommended before you attempt to solve a problem using any of the modules.

Selecting a Module

After starting The Management Scientist, you will encounter the Select a Module menu shown in Figure 
1.1. The choices provide access to the 12 modules. Click the desired module title and a brief description 
of the module will appear on the screen. To use the selected module simply click OK or, alter natively, 
double click the module title.

Figure 1.1  The Select a Module Menu

Creating a New Problem

Whenever you want to begin working on a new problem, choose the appropriate module and select the 
File pull-down menu. Then, click New to begin the data input process and create the new problem.
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Saving a Problem

You may save a problem by selecting the File pull-down menu shown in Figure 1.2 and then selecting the 
Save Problem option. This will enable you to name the problem and save it for later use. The Inventory 
and Waiting Line modules have a Save button directly on the data input dialog box. The Save button will 
enable you to save the problem without accessing the File pull-down menu.

After you specify the name of the problem, The Management Scientist automatically adds a three-
letter extension. The extension is used to identify the module used to create the problem. For example, 
suppose you have a linear programming problem that you want to save using the name LPExample. The 
Management Scientist will add the extension LPM so that your problem will be saved as a file 
LPExample.LPM. Only files with the LPM extension can be saved and retrieved with the Linear 
Programming module. Other modules have their own three-letter extensions. While you can see the 
extensions on your directory of saved problems, you do not have to input the extensions because they are 
handled automatically by The Management Scientist.

Many users who elect to save problems find it a good file management practice to create a 
separate folder for saved problems. If you wish to do this, you will need to create your own problem 
folder. Then, whenever you select the Save Problem option, you will be able to designate your problems 
folder as the place where you want to save the problem. 

Opening a Saved Problem

Suppose that you have previously saved a problem and that you now want to open the problem file so 
that the problem can be modified and/or solved again. Select the File pull-down menu shown in Figure 
1.2 and then select the Open option. You will obtain a list of saved problems for the active module. Select 
the problem you want to open and it will appear on your screen ready for modification and/or solution.

Editing a Problem

Once you have created a new problem or opened a saved problem, you may make modifications, 
changes, or corrections right on the screen. If you have solved a problem and the solution is on the 
screen, you may go back and edit the problem by selecting the Edit pull-down menu. Selecting the 
Display/Edit the Problem option will display the problem’s data input screen. You can use this screen to 
make changes to the problem. This editing process can be repeated any number of times, allowing you to 
learn how the solution changes as various aspects of the problem are modified.

For most of the modules, the Edit pull-down menu only has the Display/Edit the Problem option. 
However, some of the modules have an additional editing option. For example, the Linear Programming 
and Integer Linear Programming modules have options on the Edit pull-down menu that allow you to 
change the number of variables and/or the number of constraints for the problem. The Transportation 
and Assignment modules also have Edit options that enable you to change the size of the problem.
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Solving a Problem

When you have created a new problem, opened a saved problem, or edited a current problem, you will 
most likely want to solve it. Select the Solution pull-down menu. Then selecting Solve will solve the 
problem and display the solution on the screen. The Inventory and Waiting Line modules have a Solve 
button on the data input dialog box. In these modules, the Solve button will enable you to display the 
solution without accessing the Solution pull-down menu.

Printing or Saving a Solution

Once the solution appears on the screen, you may want to send it to a printer or save it as a text file. This 
is accomplished by selecting the Solution pull-down menu and then choosing either the Print or the Save 
as Text File options. A text file can be later accessed by a word processor so that the solution output can 
be edited and displayed as part of a solution report.

Changing Modules

After working with one module, you may want to change to a different module and solve another type of 
problem. Selecting the File pull-down menu and then selecting the Change Modules option will return 
you to the Select a Module screen shown in Figure 1.1. At this point, you may choose another module.

Exiting The Management Scientist

When you have completed a session with The Management Scientist, select the File pull-down menu and 
then select the Exit option.

1.5  OTHER CONSIDERATIONS

We have covered most of the general features of The Management Scientist. The following chapters 
contain more detailed information about particular modules. Each module chapter provides one or more 
example problems with a demonstration and discussion of data input, editing, special features, and 
output. The following additional comments and suggestions may be helpful as you use The Management 
Scientist.

Moving Around the Screen

In using The Management Scientist you will need to move around the screen in order to select menus and 
interact with data input dialog boxes. The mouse, the Tab key, and the arrow keys are the primary ways 
to navigate The Management Scientist package. Using the mouse provides the greatest degree of 
flexibility. Moving the mouse and clicking lets you move to any menu or cell on the screen. During 
sessions with data input and interactions with dialog boxes, the Tab key is very helpful. The Tab 
sequence is designed to move you through the most logical sequence of problem description and data 
input. After each piece of information is entered, the Tab key will signal the computer to accept the cell’s 
input and move the cursor automatically to the next logical step of the input process. If the Tab key 
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results in a move that is not where the user wants to go, the mouse can be used to reposition the cursor. 
The arrow keys may be used to navigate data input worksheets.

The mouse can be used to open the File, Edit, and Solution pull-down menus and to select options 
from the menus. In addition to the mouse, key strokes can be used. The underlined letter in the menu or 
option title indicates the keystroke to use. Specifically, Alt-F will open the File pull-down menu, Alt-E 
will open the Edit pull-down menu, and Alt-S will open the Solution pull-down menu. Once a pull-down 
menu is opened, the Alt key is no longer required and the underlined letter for the desired option can be 
used. For example, in the File pull-down menu, N will activate New, O will activate Open, S will activate 
Save, M will activate Change Modules, and X will activate Exit.

Some Advice for Data Input

1. Do not enter commas (,) with your input data. For example, to enter the numerical value of 
104,000, simply type the six digits 104000.

2. Do not enter the dollar sign ($) for profit or cost data. For example, a cost of $20.00 should be 
entered as 20.

3. Do not enter the percent sign (%) if percentage input is requested. For a percentage of 25%, 
simply enter 25. Do not enter 25% or .25.

4. Occasionally a quantitative model will be formulated with fractional values such as 1/4, 2/3, 
5/6, and so on. The data input for the computer must be in decimal form. The fraction of 1/4 can 
be entered as .25. However, the fractions 2/3 and 5/6 have repeating decimal forms. In cases 
such as these we recommend the convention of rounding to 5 places. Thus, the corresponding 
decimal values of .66667 and .83333 should be entered.

5. Finally, we recommend that in general you attempt to scale extremely large or extremely small 
input data so that numbers of roughly the same magnitude may be input and operated on by the 
computer. For example, a cost of $2,500,000 may be scaled to 2.5 with the understanding that 
the data used in the problem reflect millions of dollars.

Special Error Messages

All modules check input data for validity before proceeding. If data input is not acceptable to the 
module, the computer will either not accept it or will send a “beep” and a brief message describing the 
difficulty. In most cases the messages will be self-explanatory and simply give you the opportunity to re-
enter corrected data values.



8

CHAPTER 2

LINEAR PROGRAMMING

Linear programming is one of the most widely used quantitative approaches to decision making. Most 
large corporations make at least some use of linear programming, and applications are numerous. For 
instance, linear programming has been used to assist in production scheduling, choose a portfolio that 
will maximize return subject to constraints on risk, solve a variety of resource allocation problems, and 
so on.

A linear programming problem is a mathematical model of a decision-making problem. The 
mathematical model is called a linear program because it consists of a linear objective function and a 
set of linear constraints. Solving the linear program means to optimize (maximize or minimize) the 
objective function subject to the limitations and requirements represented by the constraints.

To use a linear programming approach, a mathematical model that describes the objective 
function of the problem as well as the constraints must be formulated. Once this linear program has been 
developed, the Linear Programming module of The Management Scientist can be used to find the 
optimal solution.

2.1  OVERVIEW

The Linear Programming module uses the revised simplex method with LU decomposition to solve linear 
programs containing up to 100 variables and 50 constraints.  Significant features available with this 
module include:

1. The use of variable names of up to eight characters in length.

2. An on-screen editing capability that simplifies modifying problem coefficients, adding and 
deleting variables, and so on.

3. A standard output that includes the optimal solution as well as sensitivity analysis information. 
Dual prices and ranges for the objective function coefficients and right-hand sides are provided.

4. Easy-to-use menus that simplify solving linear programming problems for beginning students 
but still provide extensive problem-solving capabilities for more experienced users.

5. The ability to save and retrieve problems from any disk drive and subdirectory; when the user 
asks to retrieve a problem, a list of all previously saved problems is displayed.
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6. An extensive error checking capability that prevents the user from getting “hung up” because of 
an error in input.

2.2  AN EXAMPLE PROBLEM

Par, Inc., a small manufacturer of golf equipment and supplies, would like to develop a quarterly 
production plan for its standard and deluxe golf bags. A careful analysis of manufacturing requirements 
resulted in Table 2.1, which shows the production time requirements for the four manufacturing 
operations and the accounting department’s estimate of the profit contribution per bag.

Production Time (Hours)
Cutting Inspection Profit

and and per
Product Dyeing Sewing Finishing Packaging Bag
Standard 7/10 1/2 1 1/10 $10
Deluxe 1 5/6 2/3 1/4 $9

Table 2.1  Production Requirements and Profit Contributions per Bag

The director of manufacturing estimates that 630 hours of cutting and dyeing time, 600 hours of 
sewing time, 708 hours of finishing time, and 135 hours of inspection and packaging time will be 
available for the production of golf bags during the next three months. Par’s problem is to determine 
how many standard and how many deluxe bags should be produced in order to maximize profit 
contribution.

Letting S = number of standard bags Par, Inc., produces and D = number of deluxe bags Par, Inc., 
produces, the following mathematical model can be used to find the combination of S and D that satisfies 
all the constraints and, at the same time, yields a value for the objective function that is greater than or 
equal to the value given by any other feasible solution.

max 10S + 9D

s.t.

� 

7
10

 S + 1 D  630 Cutting and Dyeing

� 

1
2

 S +

� 

5
6

 D  600 Sewing

1 S +

� 

2
3

 D  708 Finishing

� 

1
10

 S +

� 

1
4

 D  135 Inspection/Packaging

S, D
 
 0

2.3  CREATING AND SOLVING A PROBLEM
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To solve the Par, Inc., problem, we begin by selecting the Linear Programming module and choosing 
New from the File menu; the Problem Features dialog box will then appear. Figure 2.1 shows the 
Problem Features dialog box after entering 2 for the Number of Decision Variables, 4 for the Number of 
Constraints, and choosing Maximize for the Optimization Type. After selecting OK, we obtain the data 
input screen shown in Figure 2.2. Note that the two decision variables have initially been given the 
names X1 and X2, and that the four constraints are labeled Constraint 1, Constraint 2, Constraint 3, and 
Constraint 4.

Figure 2.1  Problem Features Dialog Box
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Figure 2.2  Initial Data Input Screen
After renaming the decision variables and entering the objective function coefficients, the 

constraint coefficients, the constraint relationships, and the right-hand side values, the data input screen 
appears as shown in Figure 2.3. Because all fractional coefficients must be converted to their decimal 
equivalent, the coefficient of S in the cutting and dyeing constraint must be written as .7 instead of 7/10, 
the coefficient of S in the sewing constraint must be written as .5 instead of 1/2, and so on. When 
rounding is necessary, we recommend using the closest five-place decimal value; thus, the 5/6 coefficient 
of D in the sewing constraint is written as .83333. Note also that each of the four less-than-or-equal-to 
constraints is entered using < instead or , and the nonnegativity constraints, S, D  0 do not have to be 
entered. After choosing Solve from the Solution menu, the optimal solution will be presented as shown in 
Figure 2.4. We see that the value of the optimal solution is, after rounding, 7668, and that the optimal 
solution is S = 540 standard bags and D = 252 deluxe bags.
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Figure 2.3  Data Input Screen for the Par, Inc., Problem
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LINEAR PROGRAMMING PROBLEM

MAX 10S+9D

     S.T.

       1)  0.7S+1D<630
       2)  0.5S+0.83333D<600
       3)  1S+0.66667D<708
       4)  0.1S+0.25D<135

OPTIMAL SOLUTION

Objective Function Value =      7667.99417

      Variable             Value             Reduced Costs   
   --------------     ---------------      ------------------ 
         S                  539.99842                 0.00000
         D                  252.00110                 0.00000

     Constraint        Slack/Surplus           Dual Prices    
   --------------     ---------------      ------------------
         1                    0.00000                 4.37496
         2                  120.00071                 0.00000
         3                    0.00000                 6.93753
         4                   17.99988                 0.00000

OBJECTIVE COEFFICIENT RANGES

   Variable       Lower Limit       Current Value     Upper Limit
 ------------   ---------------    ---------------  ---------------
      S                 6.30000           10.00000         13.49993
      D                 6.66670            9.00000         14.28571

RIGHT HAND SIDE RANGES

  Constraint      Lower Limit       Current Value     Upper Limit
 ------------   ---------------    ---------------  ---------------
       1              495.60000          630.00000        682.36316
       2              479.99929          600.00000   No Upper Limit
       3              580.00140          708.00000        900.00000
       4              117.00012          135.00000   No Upper Limit

Figure 2.4  Optimal Solution to Par, Inc., Problem

2.4  OTHER CONSIDERATIONS

As you solve more linear programming problems you will find that in many cases only a few of the 
variables appear in each constraint (i.e., they have coefficients of 0 in many constraints). The 
Management Scientist does not require you to enter any terms that have 0 coefficients. This can 
substantially reduce the time needed to enter a large problem.
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When entering coefficients that are 1000 or greater, do not enter any commas. For example, a 
constraint that required the variable named FUNDSINV to be less than or equal to $100,000 would be 
written as

FUNDSINV   <   100000

Note also that the $ symbol must be deleted when writing the right-hand-side value.
When you enter a constraint make sure that no variables appear on the right-hand side of the 

constraint. For example, if you have the constraint

VARONE = VARTWO + 10

you must enter this constraint as

VARONE – VARTWO = 10

Only a nonnegative numerical value may be used on the right-hand side of a constraint.
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CHAPTER 3

TRANSPORTATION
PROBLEM

The transportation problem arises frequently in planning for the distribution of goods and services from 
several supply locations to several demand locations.  Usually the amount of goods available at each 
supply location (origin) is given and there is a specified amount needed at each demand location (desti-
nation).  With a variety of shipping routes and differing costs for the routes, the objective is to determine 
how many units should be shipped from each origin to each destination so that all destination demands 
are satisfied and total transportation costs are minimized.  Other applications of the transportation 
problem involve multiperiod production and inventory scheduling, cash management, and a variety of 
network flow problems.

3.1  OVERVIEW

The Transportation module of The Management Scientist will solve transportation problems with up to 
30 origins and 30 destinations. The following input data must be entered by the user:

1. The number of origins.

2. The number of destinations.

3. The amount of supply at each origin.

4. The amount of demand at each destination.

5. The per unit cost or the per unit revenue of shipping from each origin to each destination.

3.2  AN EXAMPLE PROBLEM

Foster Generators, Inc., produces a particular type of generator at plants located in Cleveland, Ohio; 
Bedford, Indiana; and York, Pennsylvania. Production capacities for these plants over the next three-
month planning period are as follows:
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Three-Month
Production Capacity

Origin Plant (Units)

1 Cleveland 5000
2 Bedford 6000
3 York 2500

The firm distributes its generators through four regional distribution centers located in Boston, 
Chicago, St. Louis, and Lexington; the three-month forecast of demand at each distribution center is 
shown below:

Three-Month
Distribution Demand Forecast
Destination Center (Units)

1 Boston 6000
2 Chicago 4000
3 St. Louis 2000
4 Lexington 1500

Management would like to determine the number of units to ship from each plant to each 
distribution center.  Since the production costs are the same at each plant, the only variable costs 
involved are transportation costs. Thus the problem becomes one of determining the distribution routes 
to be used and the quantity to be shipped via each route so that all distribution center demands can be 
met with a minimum total transportation cost. The cost for each unit shipped on each route is given in 
Table 3.1.

Destination

Origin Boston Chicago St. Louis Lexington

Cleveland 3 2 7 6
Bedford 7 5 2 3
York 2 5 4 5

Table 3.1  Transportation Cost per Unit for the Foster Generators Problem

3.3  CREATING AND SOLVING A PROBLEM

To solve the Foster Generators transportation problem, we begin by selecting the Transportation module 
and choosing New from the File menu; the Origins and Destinations dialog box will then appear. Figure 
3.1 shows this dialog box after entering 3 for the number of origins and 4 for the number of destinations. 
After selecting OK, we obtain the Transportation Tableau data input screen shown in Figure 3.2. 
Transportation cost per unit data from Table 3.1 are entered into the corresponding cells of the 
Transportation Tableau. Cleveland) to destination 1 (Boston) cell, $2 per unit for origin 1 (Cleveland) to 
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destination 2 (Chicago), and so on. After the cost per unit data are entered, the origin supplies are 
entered in the right-hand column of the tableau and destination demands are entered in the bottom row 
of the tableau. When the data input process is complete, choosing Solve from the Solution menu provides 
a Select Optimization Criteria dialog box where the user may specify whether a maximization objective 
or minimization objective is desired. Selecting minimization for the Foster Generators and clicking OK 
provides the optimal transportation solution as shown in Figure 3.3. Recalling the following origin and 
destination numbers,

Origins Destinations

1. Cleveland 1. Boston
2. Bedford 2. Chicago
3. York 3. St. Louis

4. Lexington

the minimum cost solution calls for shipping 3500 units from Cleveland to Boston, 1500 units from 
Cleveland to Chicago, 2500 units from Bedford to Chicago, 2000 units from Bedford to St. Louis, 1500 
units from Bedford to Lexington, and 2500 units from York to Boston. The total transportation cost of 
this solution is shown to be $39,500.

Figure 3.1  Origins and Destinations Dialog Box
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Figure 3.2  Transportation Tableau Data Input Screen

Figure 3.3  Solution Screen for the Foster Generators Problem
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3.4  OTHER CONSIDERATIONS

When supply is not equal to demand, the Transportation module recognizes the condition automatically. 
If supply is greater than demand, the solution will indicate which origins have excess supply. If demand 
exceeds supply, the program will find the best solution for the existing supply; the destinations having 
unsatisfied demand are then displayed.

If there are origin–destination combinations that are unacceptable, you must still enter a cost or 
revenue for each unacceptable combination. To ensure that these unacceptable transportation routes are 
not included in the optimal solution, enter a very large cost (e.g., 999999) or a very small revenue (e.g., 
–999999) where appropriate.

The Transportation module provides the capability to add or delete origins and to add or delete 
destinations to an existing transportation problem.  Use the Edit menu to select the desired Add/Delete 
Origins or Destinations.  The Transportation Tableau will be displayed so that the cost per unit and the 
supply or demand data may be entered.

Finally, if the user does not enter data in one or more cells of a Transportation Tableau, The 
Management Scientist will assign 0 values to these cells. When Solve is selected, The Management 
Scientist will provide a warning message that some of the data cells have 0 entries. The user may return 
to the Transportation Tableau and replace the 0 entries with appropriate data or the user may solve the 
transportation problem with 0 entries assumed.
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CHAPTER 4

ASSIGNMENT PROBLEM

The assignment problem arises in a variety of decision-making situations. Typical assignment problems 
involve assigning jobs to machines, assigning workers to tasks or projects, assigning sales personnel to 
sales territories, assigning contracts to bidders, and so on. In general terms, the assignment problem can 
be thought of as assigning agents to tasks. A distinguishing feature of the assignment problem is that one 
agent is assigned to one and only one task. The goal is to choose the set of assignments that will optimize 
a stated objective, such as minimize cost, minimize time, or maximize profits.

4.1  OVERVIEW

The Assignment module of The Management Scientist will find the optimal solution to assignment 
problems with up to 30 agents and/or 30 tasks. The following input data must be entered by the user:

1. The number of agents.

2. The number of tasks.

3. The cost or revenue associated with assigning each agent to each task.

4.2  AN EXAMPLE PROBLEM

Fowle Marketing Research, Inc., is faced with the problem of assigning three available project leaders 
(agents) to each of three new research studies (tasks). Fowle’s management realizes, however, that the 
time required to complete each study will depend on the experience and ability of the project leader 
assigned to the study. Since the three studies have been judged to have approximately the same priority, 
the company would like to determine the assignments that will minimize the total number of days 
required to complete all three. If a project leader is to be assigned to one and only one client, what 
assignments should be made?

With three project leaders and three clients, there is a total of nine possible assignment 
alternatives.  The alternatives and the estimated project completion times in days are summarized in 
Table 4.l.
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Client

Project Leader 1 2 3

1 Terry 10 15 9
2 Carle 9 18 5
3 McClymonds 6 14 3

Table 4.1  Estimated Project Completion Times (Days) for the Fowle Assignment Problem

4.3  CREATING AND SOLVING A PROBLEM

To solve the Fowle Marketing Research assignment problem, we begin by selecting the Assignment 
module and choosing New from the File menu; the Agents and Tasks dialog box will then appear. Figure 
4.1 shows this dialog box after entering 3 for the number of agents and 3 for the number of tasks. After 
selecting OK, we obtain the Assignment Tableau data screen shown in Figure 4.2. Assignment time data 
from Table 4.1 are entered into the corresponding cells of the Assignment Tableau. For example, Figure 
4.2 shows 10 days for the assignment of agent 1 (Terry) to task 1 (Client 1), 15 days for the assignment 
of agent 1 (Terry) to task 2 (Client 2), and so on. When the data input process is completed, choosing 
Solve from the Solution menu provides a Select Optimization Criteria dialog box where the user may 
specify whether a maximization objective or minimization objective is desired. Selecting minimization for 
the Fowle Marketing Research problem and selecting OK provides the optimal assignment solution as 
shown in Figure 4.3. Thus we see Agent 1 (Terry) is assigned to Client 2, Agent 2 (Carle) is assigned to 
Client 3 and Agent 3 (McClymonds) is assigned to Client 1. The minimum total time required to 
complete all three tasks is 26 days.

Figure 4.1  Agents and Tasks Dialog Box
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Figure 4.2  Assignment Tableau Input Screen

Figure 4.3  Solution Screen for the Fowle Marketing Research Problem
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4.4  OTHER CONSIDERATIONS

When the number of agents is not equal to the number of tasks, the Assignment module recognizes the 
condition automatically. If the number of agents is greater than the number of tasks, the solution will 
indicate which agents are unassigned. If the number of tasks exceeds the number of agents, the Assign-
ment module finds the best solution for the existing agents; the tasks that are not assigned an agent are 
then displayed.

If there are agent–task combinations that are unacceptable, you must still enter a cost or revenue 
for each unacceptable agent–task combination. To ensure that these unacceptable assignments are not 
included in the optimal solution, enter a very large cost (e.g., 999999) or a very small revenue (e.g., –
999999) where appropriate.

The Assignment module provides the capability to add or delete agents and to add or delete tasks 
to an existing assignment problem. Use the Edit menu to select the desired Add/Delete Agents or Tasks. 
The Assignment Tableau will be displayed so that the additional data may be entered.

Finally, if the user does not enter data in one or more cells of an Assignment Tableau, The 
Management Scientist will assign 0 values to these cells. When Solve is selected, The Management 
Scientist will provide a warning message that some of the data cells have 0 entries. The user may return 
to the Assignment Tableau and replace the 0 entries with appropriate data or the user may solve the 
assignment problem with the 0 entries assumed.
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CHAPTER 5

INTEGER LINEAR
PROGRAMMING

Problems that can be modeled as linear programs, except for the additional requirement that some or all 
of the variables must be integers, are called integer linear programming problems. The use of integer 
variables provides additional modeling flexibility. As a result, the number of practical applications that 
can be addressed with integer linear programming methodology is quite large.

If all of the variables are required to be integers, we say we have an all-integer linear program. 
For example, the following is an all-integer linear programming model:

max 2X1 + 3X2

s.t.

3X1 + 3X2  12

2/3X1 + 1X2  4

1X1 + 2X2  6

X1, X2  0 and integer

Note that if the phrase “and integer” is dropped from the above model we are left with the familiar two-
variable linear program.

If some, but not all, of the variables in a problem are required to be integers, we say we have a 
mixed-integer linear program. For example, in the above model if the phrase “and integer” is replaced 
by “and X2 integer” we would have a mixed-integer linear program. In this case although X2 would be 
restricted to only integer values, X1 would be said to be continuous; it could assume any value greater-
than-or-equal-to zero.

In most practical applications, the integer variables are only permitted to assume the values 0 or 1.  
In such cases, we say that we have a binary, or a 0–1, integer linear program.  Zero–one problems may 
be either the all-integer or mixed-integer type.

5.1  OVERVIEW

The Integer Linear Programming module of The Management Scientist employs a branch and bound 
solution procedure. It can solve all-integer, mixed-integer, and 0–1 integer linear programs with up to 
100 variables and 50 constraints. However, problems with large numbers of integer variables may solve 
slowly. Just as with the Linear Programming module, 
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the number of decision variables that can be used must allow for slack, surplus, and artificial variables 
that are added automatically by the Integer Linear Programming module.

Since the Linear Programming module and the Integer Linear Programming module are the same 
with respect to creating, retrieving, saving, and editing a problem, we will focus our attention on the 
differences associated with solving integer linear programs. Readers unfamiliar with the Linear Pro-
gramming Module of The Management Scientist should review Chapter 2 before continuing with this 
chapter.

5.2  AN EXAMPLE PROBLEM: 
THE ALL-INTEGER CASE

Eastborne Realty currently has $2,000,000 available to purchase townhouses or apartment buildings. 
Each townhouse can be purchased for the price of $282,000, but there are only five townhouses 
available for purchase at this time. Each apartment building sells for $400,000, and the developer has 
agreed to build as many units as Eastborne would like to purchase.

Eastborne’s property manager is free to devote 140 hours per month to these investments. Each 
townhouse will require 4 hours of the property manager’s time each month, while each apartment 
building will require 40 hours per month. The yearly cash flow (after deducting mortgage payments and 
operating expenses) is estimated at $10,000 per townhouse and $15,000 per apartment building. 
Eastborne would like to allocate its investment funds to townhouses and apartment buildings in order to 
maximize the yearly cash flow.

To develop an appropriate mathematical model, let us introduce the following decision variables:

T = number of townhouses purchased

A = number of apartment buildings purchased

The objective function, measuring cash flow in thousands of dollars, can be written as

max 10T + 15A

There are three constraints that must be satisfied:

282T + 400A  2000 Funds available ($1000s)

4T + 40A  140 Manager’s time (hours)

T  5 Townhouses available

Adding the nonnegativity requirements we obtain a linear programming model involving the two 
variables and three constraints.  This model could be solved using the Linear Programming module 
described in Chapter 2; the optimal linear programming solution is T = 2.479 and A = 3.252, with an 
objective function value of $73,574.

However, since fractional values do not make any sense in the context of the problem, the standard 
linear programming approach to this problem is not appropriate.  What we need to do is add the 
requirement that both T and A are restricted to integer values. Doing this, we obtain the following all-
integer linear programming model:
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max 10T + 15A

s.t.

282T + 400A  2000 Funds available ($1000s)

4T + 4A  140 Manager’s time (hours)

T  5 Townhouses available

T, A  0 and integer

5.3  CREATING AND SOLVING A PROBLEM

To solve the Eastborne Realty problem, we begin by selecting the Integer Linear Programming module 
and choosing New from the File menu; the Problem Features dialog box will then appear.  Figure 5.1 
shows the Problem Features Dialog box after entering 2 for the Number of Decision Variables, 3 for the 
Number of Constraints, and choosing Maximize for the Optimization Type.  After clicking OK, we obtain 
the data input screen shown in Figure 5.2. Note that the two decision variables have initially been given 
the names X1 and X2, and that the three constraints are labeled Constraint 1, Constraint 2, and 
Constraint 3.

Figure 5.1  Problem Features Dialog Box
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Figure 5.2  Initial Data Input Screen 

After renaming the variables, entering the objective function coefficients, the constraint coeffi-
cients, the constraint relationships, and the right-hand-side values, we obtain the data input screen 
shown in Figure 5.3. After choosing Solve from the Solution menu, we obtain the Integer Variable 
Identification dialog box shown in Figure 5.4. After selecting the All Variables Are General Integer 
option and choosing Solve, the optimal solution will be presented as shown in Figure 5.5 (page 28).
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Figure 5.3  Data Input Screen for the Eastborne Realty Problem

Figure 5.4  Integer Variable Identification Dialog Box
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Figure 5.5  Optimal Solution to the Eastborne Realty Problem

We see that the optimal solution for Eastborne Realty is to purchase four townhouses (T = 4) and 
two apartment buildings (A = 2); this solution corresponds to a yearly cash flow of $70,000.

Note that the form of the optimal solution output is similar to that of the Linear Programming 
module. However, the reduced costs and dual prices are not given. This is because they do not have the 
same meaning as for linear programming problems. Also, no ranging information is given for objective 
function coefficients and right-hand sides.  Such information is not meaningful for integer linear 
programs.

5.4  AN EXAMPLE PROBLEM: 
THE 0–1 ALL-INTEGER CASE

The Ice-Cold Refrigerator Company can invest funds over the next four years in a variety of company 
projects that have differing capital requirements.  Faced with limited funds, the company must select the 
most profitable projects and budget for the necessary capital expenditures.  The estimated present values 
for the projects, the capital requirements, and the available capital projections are as follows:



30

Estimated
Present Capital Requirements

Project Value($) Year l Year 2 Year 3 Year 4

Plant expansion 90,000 15,000 20,000 20,000 15,000

Warehouse expansion 40,000 10,000 15,000 20,000 5,000

New machinery 10,000 10,000 0 0 4,000

New product research 37,000 15,000 10,000 10,000 10,000

Available capital funds 40,000 50,000 40,000 35,000

The following decision variable definitions are used:

P  = 1 if the plant expansion project is accepted; 0 if rejected

W = 1 if the warehouse expansion project is accepted; 0 if rejected

M = 1 if the new machinery project is accepted; 0 if rejected

R = 1 if the new product research project is accepted; 0 if rejected

Using these decision variable definitions, the objective function can be written as shown below 
(monetary values are expressed in thousands of dollars):

max 90P + 40W + 10M + 37R

The mathematical model of this capital budgeting problem has a separate constraint for each year’s 
available funds; thus we obtain the following four constraints:

15P + 10W + 10M + 15R  40

20P + 15W 10R  50

20P + 20W 10R  40

15P + 5W + 4M + 10R  35

P, W, M, R = 0,1

To solve the above integer linear programming problem using the Integer Linear Programming 
module, we enter the problem in the usual fashion.  After verifying that the problem has been entered 
correctly, we choose Solve from the Solution menu. Then, in the Integer Variable Identification dialog 
box, we select the All Variables Are 0/1 (Binary) option and choose Solve; the optimal solution, shown in 
Figure 5.6, is given by P = 1, W = 1, M = 1, and R = 0 with a total estimated present value of $140,000.
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Figure 5.6  Optimal Solution to the Ice-Cold Refrigerator Company Problem

5.5  AN EXAMPLE PROBLEM: 
THE MIXED-INTEGER CASE

Suppose that we had the following mixed-integer linear programming problem:

max 1X1 + 1X2

s.t.

7X1 + 9X2  63

9X1 + 5X2  45

3X1 + 1X2  12

X1, X2  0 and X2 integer

After entering this problem, we choose Solve from the Solution menu.  Then, in the Integer Variable 
Identification dialog box we select the Multiple Types of Variables option.  From the General Integer 
Variables list we choose X2.

After selecting Solve, the optimal mixed integer solution is displayed as shown in Figure 5.7.
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Figure 5.7  Optimal Solution to the Mixed-Integer Example Problem

5.6  OTHER CONSIDERATIONS

The Integer Linear Programming module of The Management Scientist is a general integer 
programming system; that is, it has the capability of solving every type of integer linear programming 
problem. A branch and bound solution procedure, which requires the solution of a linear programming 
problem at each node, is employed. The number of computations involved in solving these problems can 
be substantial for even moderately sized problems. Thus, solution times may take as long as several 
minutes for more difficult problems and will depend on the speed of your personal computer.
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CHAPTER 6

SHORTEST ROUTE

In this chapter, we consider the network application of designing a transportation system where the 
primary interest is in determining the shortest route or shortest path through the network. These types of 
problems arise in situations where it is desired to transport goods between a variety of locations and the 
objective is to find the most economical route between various pairs of locations.

The cost of transporting goods from one location to another is usually measured in distance 
traveled, but travel time or dollar cost could be used just as easily. Other situations in which the need to 
solve a shortest route problem might arise, include the design of computer networks, vehicle routing 
problems, and so on.

6.1  OVERVIEW

The Shortest Route module of The Management Scientist will find the shortest route between any 2 nodes 
in a network consisting of up to 20 nodes and 40 arcs. To create and solve a new problem, the user must 
first develop a network diagram of the problem to be solved and then provide the following data input to 
the Shortest Route module:

1. The number of nodes

2. The number of arcs

3. For each arc:

a. The number of the start node

b. The number of the end node

c. The distance (or other measure used) between the nodes

4. The 2 nodes it is desired to find the shortest route between

6.2  AN EXAMPLE PROBLEM

The Gorman Construction Company operates several construction projects located throughout a three-
county area. With multiple daily trips carrying personnel, equipment, and supplies to and from the 
construction sites, the costs associated with transportation activities are substantial. The network shown 
in Figure 6.1 describes the travel alternatives to and 
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from six of Gorman’s newest construction sites. The circles (nodes) of the network correspond to the site 
locations. The lines between the nodes (arcs) correspond to the roads and the streets between the 
locations. The numbers next to each arc represent road distances in miles. If Gorman wishes to minimize 
the travel distance from the office to site 7, what is the route that should be followed? Note that the net-
work has 7 nodes and 10 arcs.

Figure 6.1  Road Network for the Gorman Shortest Route Problem

6.3  CREATING AND SOLVING A PROBLEM

To solve the Gorman shortest route problem, we begin by selecting the Shortest Route module and 
choosing New from the File menu; the Nodes and Arcs dialog box will then appear. Figure 6.2 shows 
this dialog box after entering 7 for the number of nodes and 10 for the number of arcs. After selecting 
OK, we obtain the Network Description data input screen shown in Figure 6.3. Net work description 
data are entered into the corresponding cells. For example, row 1 corresponds to arc 1 of the network, 
which starts at node 1, ends at node 2, and has a distance of 15 miles. Row 2 corresponds to arc 2 of the 
network, which starts at node 1, ends at node 3, and has a distance of 10 miles. The numbering of the 10 
arcs as shown in Figure 6.3 is arbitrary. A different user might number the arcs differently and input the 
network description data in a different order. The Management Scientist is flexible and can accept the 
network arc descriptions in any order. When the data input process is completed, choosing Solve from 
the Solution menu provides a Select the Starting and Ending Nodes dialog box where the user may 
specify any starting node and any ending node in the network. Selecting starting node 1 and ending node 
7 for the Gorman problem and selecting OK provides the optimal shortest route as shown in Figure 6.4. 
Thus we see that the shortest route between nodes 1 and 7 passes through nodes 3, 5, and 6. The total 
distance is 22 miles.
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Figure 6.2  Nodes and Arcs Dialog Box

Figure 6.3  Network Description Data Input Screen
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Figure 6.4  Shortest Route Between Nodes 1 and 7 for the Gorman Problem

At this point, the user may select Solve from the Solution menu again. Altering the starting node 
and/or ending node and selecting OK will provide the shortest route between the two specified nodes. 
This process can be repeated in order to find the shortest route between any other pair of nodes in the 
network.
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CHAPTER 7

MINIMAL 
SPANNING TREE

The minimal spanning tree problem involves using the arcs of the network to connect all nodes in such a 
fashion that the total length of the arcs used is minimized. As with the shortest route problem, it is 
customary to use distance as a measure of arc length. However, in some applications it is more 
appropriate to use arc cost, time to go from one node to another, and so on.

A common situation in which the minimal spanning tree problem arises involves the design of 
communication networks, where the objective is to minimize the amount of the cable necessary to 
connect all nodes that must communicate with one another. Other applications involve designing road 
networks, developing the layout for conveyor systems, and so on.

7.1  OVERVIEW

The Minimal Spanning Tree module of The Management Scientist will find the optimal solution to 
minimal spanning tree problems with up to 20 nodes and 40 arcs. The module will find the set of arcs 
that creates a path connecting every node to every other node in such a manner that the total length of 
all arcs used is minimized. To create and solve a new problem, the user must first develop a network 
diagram of the problem to be solved and then provide the following input data:

1. The number of nodes

2. The number of arcs

3. For each arc:

a. The number of the start node

b. The number of the end node

c. The distance (or other measure used) between the nodes

7.2  AN EXAMPLE PROBLEM

The Southwestern Regional Computer Center must have special computer communication lines installed 
in order to connect five satellite users with a new central computer. Because 
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the lines are expensive, the computer center’s management wants the total length of the new 
communication lines to be as small as possible. While the central computer could be connected directly 
to each user, it appears to be more economical to install a direct line to some users and let other users 
tap into the system by linking up with the users who are already connected to the system. The network 
shown in Figure 7.1 shows us the links being considered between the regional computer center and the 
satellite users. The distance, in miles, between locations is shown above the associated arcs. Note that 
the network has 6 nodes and 11 arcs.

Figure 7.1  Communications Network for the Regional Computer System

7.3  CREATING AND SOLVING A PROBLEM

To solve the Regional Computer System minimal spanning tree problem, we begin by selecting the 
Minimal Spanning Tree module and choosing New from the File menu; the Nodes and Arcs dialog box 
will then appear. Figure 7.2 shows this dialog box after entering 6 for the number of nodes and 11 for 
the number of arcs. After selecting OK, we obtain the Network Description data input screen shown in 
Figure 7.3. Network description data are entered into the corresponding cells. For example, row 1 
corresponds to arc 1 of the network, which starts at node 1, ends at node 2, and has a distance of 20 
miles. Row 2 corresponds to arc 2 of the network, which starts at node 1, ends at node 3, and has a 
distance of 40 miles. The numbering of the 11 arcs as shown in Figure 7.3 is arbitrary. A different user 
might number the arcs differently and input the network description data in a different order. The 
Management Scientist is flexible and can accept the network arc descriptions in any order. When the 
data input process is completed, choosing Solve from the Solution menu provides the minimal spanning 
tree solution as shown in Figure 7.4 (page 39). Thus we see that 
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communication lines must be installed between five pairs of locations: 1 and 2, 1 and 4, 4 and 3, 4 and 6, 
and 3 and 5. The total length of the communication lines is 110 miles.

Figure 7.2  Nodes and Arcs Dialog Box

Figure 7.3  Network Description Data Input Screen
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Figure 7.4  Minimal Spanning Tree for the Regional Computer Center Problem
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CHAPTER 8

PERT/CPM

PERT (Program Evaluation and Review Technique) and CPM (Critical Path Method) are approaches 
management scientists have developed to assist managers with planning, scheduling, and controlling 
projects. PERT and CPM were initially developed independently for slightly different purposes, but in 
today’s usage, the distinction between PERT and CPM as two separate techniques has largely 
disappeared.

PERT/CPM has been used to plan, schedule, and control a wide variety of projects, such as:

1. Research and development of new products and processes

2. Construction of plants, buildings, and highways

3. Maintenance of large and complex equipment

4. Design and installation of new systems

In projects such as the above, project managers must schedule and coordinate the various activities so 
that the entire project is completed on time. A complicating factor in carrying out this task is the 
interdependence of the activities; some activities depend on the completion of other activities before they 
can be started. The PERT/CPM technique can assist managers by helping them answer questions such 
as the following:

1. What is the time required to complete the project?

2. What start and finish dates should be scheduled for each activity?

3. Which are the critical activities?

4. How long can noncritical activities be delayed before they become critical?

8.1  OVERVIEW

The PERT/CPM module of The Management Scientist can be used to analyze projects with up to 25 
activities. The program will develop an activity schedule, identify the critical activities, and compute the 
expected project completion time. It can be used for projects with known activity completion times and 
for projects with uncertain activity completion times. 
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For projects with uncertain activity completion times, the PERT/CPM module will compute the expected 
time and variance for each activity as well as the expected completion time and variance for the entire 
project.

Before using the PERT/CPM module, the user must develop a list of the activities and, for each 
activity, the immediate predecessors. Each activity must be identified by a letter of the alphabet and no 
activity may have as an immediate predecessor an activity identified by a letter coming later in the 
alphabet. The data input requirements differ depending on whether activity times are known or 
uncertain. We illustrate the use of the module in both cases.

8.2  AN EXAMPLE PROBLEM WITH 
KNOWN ACTIVITY COMPLETION TIMES

The owner of the Western Hills Shopping Center is considering modernizing and expanding his current 
32-store shopping complex. The activities necessary to complete the expansion project are listed in Table 
8.1. Note that the list includes the immediate predecessor for each activity as well as the number of 
weeks required to complete the activity.

Completion
Activity Immediate Time

Activity Description Predecessor (Weeks)

A Prepare architectural drawings — 5
B Identify potential tenants — 6
C Develop prospectus A 4
D Select contractor A 3
E Prepare building permits A 1
F Secure approval of building permits E 4
G Construction D, F 14
H Finalize tenant contracts B, C 12
I Tenants move in G, H 2

Table 8.1  Activity List for the Western Hills Shopping Center Expansion Project

Information in Table 8.1 indicates that the total time required to complete all activities in the 
shopping center expansion project is 51 weeks. However, from the immediate predecessor information, 
we see that several of the activities can be completed simultaneously (A and B, for example). Being able 
to work on two or more activities at the 
same time will shorten the total project completion time to less than 51 weeks. We now show how the 
PERT/CPM module can be used to provide information in managing this project.

8.3  CREATING AND SOLVING A PROBLEM

To analyze the Western Hills Shopping Center expansion project, we begin by selecting the PERT/CPM 
module and choosing New from the File menu; the PERT/CPM Parameters dialog box will then appear. 
Figure 8.1 shows the PERT/CPM Parameters dialog box after 
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selecting the Known Activity Times option and entering 9 for the Number of Activities. After selecting 
OK, we obtain the data input screen shown in Figure 8.2.

Figure 8.1  PERT/CPM Parameters Dialog Box

Figure 8.2  Initial Data Input Screen
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For each of the nine activities in the Select Activity Name list we must identify each activity’s 
immediate predecessor and the expected activity time for each activity. For example, we begin by 
clicking the letter A in the Select Activity Name list. Since A does not have any immediate predecessor, 
we only need to enter the expected completion time of 5 in the Expected Time box. The input for other 
activities follows in a similar fashion, with the exception that for activities with immediate predecessors, 
we must also choose the immediate predecessors from the Select Predecessor list. Figure 8.3 shows the 
data input screen after entering all the data for the Western Hills Shopping Center expansion project. 
After choosing Solve from the Solution menu, the activity schedule, critical path, and project completion 
time will be displayed as shown in Figure 8.4.

Figure 8.3  Data Input Screen for the Western Hills Shopping Center Project
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Figure 8.4  Activity Schedule for the Western Hills Shopping Center Project

Activities A–E–F–G–I are on the critical path and the project may be completed in 26 weeks. The 
earliest start, latest start, earliest finish, latest finish, and slack times are shown for each activity.

8.4  AN EXAMPLE PROBLEM WITH UNCERTAIN 
ACTIVITY COMPLETION TIMES

The H.S. Daugherty Company is considering manufacturing a cordless vacuum cleaner that can be 
powered by a rechargeable battery. The vacuum cleaner, referred to as a Porta-Vac, is expected to 
contribute to Daugherty’s expansion into the household market. Daugherty’s management has initiated a 
project to study the feasibility of proceeding with the Porta-Vac idea. The list of activities and immediate 
predecessors are shown in Table 8.2.
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Immediate
Activity Description Predecessors

A Develop product design —
B Plan market research —
C Routing (manufacturing engineering) A
D Build prototype model A
E Prepare marketing brochure A
F Cost estimates C
G Preliminary product testing D
H Market survey B, E
I Pricing and forecast report H
J Final report F, G, I

Table 8.2  Activity List for the Daugherty Porta-Vac Project

For the Daugherty Porta-Vac project, activity times are uncertain. In such cases, the PERT 
procedure calls for three time estimates (optimistic, most probable, and pessimistic) to be used for each 
activity. The activity time estimates for the Porta-Vac project are given in Table 8.3.

Most
Optimistic Probable Pessimistic

Activity Time Time Time

A 4 5 12
B 1 1.5 5
C 2 3 4
D 3 4 11
E 2 3 4
F 1.5 2 2.5
G 1.5 3 4.5
H 2.5 3.5 7.5
I 1.5 2 2.5
J 1 2 3

Table 8.3  Optimistic, Most Probable, and Pessimistic Activity Time Estimates (in weeks) for the Porta-
Vac Project

To analyze the Daugherty Porta-Vac project using the PERT/CPM module, we begin by choosing 
New from the File menu. In the Enter PERT /CPM Parameters dialog box, we select the Uncertain 
Activity times option, enter 10 for the Number of Activities, and select OK; the problem input screen will 
then appear. Then, for each activity, in addition to the information on immediate predecessors, we must 
enter the optimistic, most probable, and pessimistic time estimates; Figure 8.5 shows the resulting 
problem input screen.
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Figure 8.5  Problem Input Screen for the Daugherty Porta-Vac Project

After choosing Solve from the Solution menu, we obtain the output shown in Figure 8.6. The 
PERT/CPM module prints a list of the expected times and variances for activities, followed by the 
activity schedule. The critical path, the expected project completion time, and the variance of project 
completion time are also included. For the Daugherty Porta-Vac project the critical path is A–E–H–I–J, 
with an expected project completion time of 17 weeks. The variance of project completion time is shown 
to be 2.72.
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Figure 8.6  Activity Schedule for the Daugherty Porta-Vac Project
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CHAPTER 9

INVENTORY

Inventories can be defined as any idle products or materials that are waiting to be used. For most 
companies, the expenses associated with financing and maintaining inventories are a substantial part of 
the cost of doing business.

Quantitative models of inventory systems have been developed to help managers make decisions 
such as the following:

1. How much should be ordered when the inventory for a particular item is to be replenished?

2. When should the inventory of the item be replenished?

In the best known and most fundamental inventory model, referred to as the economic order quantity 
model, the objective is to satisfy demand while minimizing inventory holding costs and ordering costs. In 
other inventory models, backorder costs, quantity discount costs, and stockout costs are also considered.

While there are many similarities in all inventory systems, each system has unique characteristics 
that prevent the application of one or two general inventory models to all situations. For example, in 
some inventory systems it may be reasonable to assume that demand is deterministic; that is, the demand 
for the item occurs at a known and constant rate. In other inventory systems, however, the demand may 
be probabilistic; that is, the demand fluctuates and can only be described in probabilistic terms.

Based on assumptions about the type of demand encountered and given relevant costs, inventory 
models can be used to provide information such as the following:

1. Minimum cost order quantity

2. Annual inventory holding cost

3. Annual order cost

4. Total annual cost

5. Maximum inventory level

6. Average inventory level

7. Reorder point
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8. Number of orders per year

9. Cycle time (time between orders)

Using the information provided by an inventory model, managers are better equipped to establish a low-
cost inventory policy.

9.1  OVERVIEW

The Inventory module of The Management Scientist provides the following six inventory models:

1. Economic Order Quantity—Given a constant demand rate, this model determines the order 
quantity that will minimize the total annual inventory holding and ordering costs.

2. Economic Production Lot Size—Given a constant demand rate and a constant production rate, 
this model determines the production lot size that will minimize the total annual inventory 
holding and production setup costs.

3. Economic Order Quantity with Planned Shortages—This model allows planned shortages or 
backorders. Given a constant demand rate, this model determines the order quantity that will 
minimize the total annual inventory holding, ordering, and backordering costs.

4. Economic Order Quantity with Quantity Discounts—This model considers cases where the 
purchase cost per unit changes depending on the order quantity. Given a constant demand rate, 
this model deter mines the order quantity that will minimize the total annual inventory holding, 
ordering, and purchasing costs.

5. Order Quantity–Reorder Point with Probabilistic Demand—This model follows the approach of 
the economic order quantity model with the addition that demand during the lead time period is 
probabilistic and described by a normal probability distribution. The model determines the 
order quantity and reorder point that will minimize annual inventory holding and ordering costs 
and provides an acceptable value for the probability of a stockout.

6. Single-Period Inventory with Probabilistic Demand—With demand described by a uniform or 
normal probability distribution, this model determines the optimal order quantity for single-
period inventory situations in which items cannot be carried in inventory from one period to the 
next.
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9.2  AN EXAMPLE PROBLEM

R&B Beverage Company is a distributor of beer, wine, and soft drink products. For each of its products, 
R&B would like to determine how much to order and when to order so that inventory holding and 
ordering costs are minimized. To illustrate how the Inventory module can help in determining answers to 
these questions, we will apply the economic order quantity model to R&B’s best selling product, Bub 
Beer.

The annual demand for Bub Beer is assumed to be approximately constant at 104,000 cases. It 
costs $32.00 to place an order with the supplier, and each case of Bub costs R&B $8.00. The annual 
inventory holding cost per unit is 25% of the cost of the item, and the R&B Beverage Company operates 
250 days per year. In addition, when a new order is placed with the supplier, it takes two days for the 
order to reach the R&B warehouse. Given these data regarding Bub Beer, management would like to 
answer the following questions:

1. What is the minimum cost order quantity of Bub Beer?

2. What is the reorder point or inventory level that signals R&B should order a new shipment of 
Bub Beer?

3. How many orders will be placed per year and what is the length of time between orders?

4. What is the total annual inventory holding and ordering cost for this product?

9.3  CREATING AND SOLVING A PROBLEM

To solve the Bub Beer inventory problem, we begin by selecting the Inventory module and choosing New 
from the File menu; the Inventory Models Available dialog box shown in Figure 9.1 will then appear. 
This dialog box can be used to select any one of the six inventory models listed. Since the Bub Beer 
problem is an economic order quantity application, we select the economic order quantity model. The 
dialog box shown in Figure 9.2 appears on the screen. The data for the Bub Beer problem are entered as 
shown. Note that the Holding Cost Method shows Percent with the Percent of Unit Cost = 25 (for 25%) 
and Unit Cost = 8. The Holding Cost Method can be changed to Amount, which requires the user to 
input the holding cost amount per unit. The Percent and Amount options enable inventory holding cost to 
be expressed as either a percentage of the unit cost or as a specific dollar amount. The Number of 
Working Days per Year will show 250 days, which is a common assumption. If 250 days per year is not 
appropriate, this entry can be changed to reflect the actual number of working days per year for the 
problem. Finally, Compute Reorder Point appears as a question since the economic order quantity 
model can be implemented with or without reorder point information. Since the Bub Beer problem 
requested reorder point information, the Compute Reorder Point box has been clicked on and the lead 
time of 2 days has been entered.
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Figure 9.1  Inventory Models Available Dialog Box

Figure 9.2  Economic Order Quantity Dialog Box

After the data input process is completed, Solve or Save can be implemented by selecting the 
appropriate button in the data input dialog box. Selecting Solve provides the optimal solution shown in 
Figure 9.3. 
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Figure 9.3  Output for the R&B Beverage Economic Order Quantity Problem

9.4  OTHER INVENTORY MODELS

There are six different inventory models that may be solved using this module (see Figure 9.1). The 
process of creating and solving a problem is similar for all the models. Here, we briefly overview the 
differences in data input and the output provided.

Economic Production Lot Size

This model is appropriate for problems involving a production run. It is similar to the economic order 
quantity model; the production lot size run corresponds to the economic order quantity and the 
production setup cost corresponds to an order cost. Attention is usually focused on the following 
questions:

1. What is the minimum cost production lot size?

2. What is the reorder point or inventory level that signals a new production run should be 
scheduled?
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3. How many production setups will be scheduled per year and what is the length of time between 
production runs?

4. What is the total annual inventory holding and setup cost for this product?

Data input for the economic production lot size model is very similar to the data input for the 
economic order quantity model shown in Figure 9.2. One additional input item—the annual production 
rate—is required for the production lot size model.

Economic Order Quantity with Planned Shortages

This inventory model uses the assumption of the economic order quantity model with the exception that it 
allows planned shortages called backorders. The model assumes that if the item is out of inventory, the 
customer requesting the item will wait until the next incoming order is received, and such back orders 
will be filled as soon as the new order is received.

Data input includes the economic order quantity data input shown in Figure 9.2 plus one 
additional piece of information: the cost per unit per year for a backorder. Output information includes 
the standard economic order quantity information shown in Figure 9.3. In addition, the planned 
stockouts model indicates the maximum number of back orders that will occur, the annual cost of the 
backorders, and the total cost including inventory holding, ordering, and backordering costs.

Economic Order Quantity with Quantity Discounts

This model is based on the economic order quantity model with the variation that purchase cost per unit 
is a relevant cost and depends on the order quantity decision. Thus, in this model it may be desirable to 
order additional units in order to obtain a quantity discount, which will result in a lower unit cost.

The economic order quantity with quantity discounts model requires the same input data as the 
economic order quantity model (see Figure 9.2). In addition, this model requires you to enter quantity 
discount information showing the unit cost and the minimum quantity to order to obtain this cost for 
each discount category.

The output information is the same as for the economic order quantity model as shown in Figure 
9.3, with the addition that purchase cost is included in the total cost. The recommended optimal order 
quantity will be in the discount category providing the lowest total cost.

Order Quantity–Reorder Point with Probabilistic Demand

This inventory model is another variation of the basic economic order quantity model. The difference 
between the two models is that the order quantity–reorder point with probabilistic demand model 
assumes that demand during the lead time is subject to uncertainty. A normal probability distribution is 
used to describe the lead time demand.

Data input includes the basic economic order quantity data input shown in Figure 9.2, with the 
exception that the reorder point is based on the input of the mean and standard deviation of the lead time 
demand rather than on the input of lead time in days. The 
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computation of the reorder point is made based on a desired service level. The service level can be 
expressed in terms of either

1. An allowable number of stockouts per year, or

2. The probability of a stockout during an inventory cycle.

The choice of the expression of service level is up to the user. Under option 1, the allowable 
number of stockouts per year is specified. Under option 2, the acceptable probability of a stockout 
during an inventory cycle is specified. Generally, most inventory systems will seek to have inventory 
available for customers and thus the allowable number of stockouts per year and the probability of a 
stockout per cycle will be low.

The output information displayed includes the economic order quantity model information shown 
in Figure 9.3. In addition the output displays the safety stock level, the safety stock cost, the expected 
number of stockouts per year, and the probability of a stockout per cycle.

Single-Period Inventory with Probabilistic Demand

This inventory model considers probabilistic demand for the situation where inventory cannot be carried 
from one period to the next. In a single-period inventory situation, one order is placed for the item; at 
the end of the period the item has either sold out or there is a surplus of unsold items, which will be sold 
for a salvage value. The single-period model applies to situations involving seasonal or perishable items 
that cannot be carried in inventory and sold in future periods.

The following three input values are required to use this model:

1. The cost of overestimating demand and ordering too much

2. The cost of underestimating demand and not ordering enough

3. The probability distribution for demand, which must be either a uniform or a normal probability 
distribution

The output information shows the optimal order quantity, the probability of a surplus, and the 
probability of a stockout.
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CHAPTER 10

WAITING LINES

Waiting lines occur in many everyday situations. People wait in supermarket check-out lines, at bank 
teller windows, in doctor offices, at gasoline service stations, at airline ticket counters, and so on. In 
general, units (customers) arrive at a service facility seeking the service provided by the facility. If the 
service facility is busy, the units form a waiting line and wait until the service facility is available.

Quantitative models have been developed that enable decision makers to identify the operating 
characteristics of waiting line systems. Typical information provided by waiting line models includes the 
following:

1. The probability that the service facility is idle and there are no units in the system

2. The average number of units in the waiting line

3. The average number of units in the system (units waiting plus units being serviced)

4. The average time a unit spends in the waiting line

5. The average time a unit spends in the system (waiting time plus service time)

6. The probability that an arriving unit has to wait for service

7. The total system cost (the cost of idle time for the units in the system plus the cost of operating 
the service facility)

Given the above information, decision makers are better able to make waiting line design and 
policy decisions that balance the desired service levels with the cost of providing the service.

10.1  OVERVIEW

The Waiting Lines module of The Management Scientist provides the following five waiting line models.

1. Single- or Multiple-Channel with Poisson Arrivals Exponential Service Times—This is the 
fundamental waiting line model with Poisson arrivals and exponential service 



57

times. Operating characteristics are provided for systems having from 1 to 25 channels.

2. Single-Channel with Poisson Arrivals and Arbitrary Service Times—This model is restricted to 
a single-channel system. However, service times may follow any probability distribution. The 
only information needed about the service times is the mean service rate and the standard devi-
ation of the service time.

3. Single-Channel with Poisson Arrivals and Deterministic Service Times—
This model considers deterministic (constant) service time for a single-channel system. All units 
require the same amount of time; no variation in service time is permitted.

4. Single- or Multiple-Channels with Poisson Arrivals, Arbitrary Service Times, and No Waiting 
Line—This model considers situations where waiting is not permitted. An arriving unit either 
receives service immediately or is blocked from the system. Blocked units are not permitted to 
wait, are cleared from the system, and may try to re-enter at a later point in time. Operating 
characteristics are provided for systems having from 1 to 25 channels.

5. Single- or Multiple-Channels with Poisson Arrivals, Exponential Service Times, and a Finite 
Calling Population—In this waiting line model, a finite population of units is permitted to arrive 
for service. Populations with a maximum of 30 units are allowed. Operating characteristics are 
provided for systems having from 1 to 25 channels.

10.2  AN EXAMPLE PROBLEM

The Burger Dome fast-food restaurant operates a single-channel service facility for its customers. A 
single Burger Dome employee takes the customer’s order, determines the total cost of the order, takes 
the money from the customer, and then fills the order. Once a customer’s order is filled, the employee 
takes the order from the next customer waiting for service. The Poisson probability distribution 
describes the customer arrivals. The mean arrival rate is 0.75 customers per minute. The exponential 
probability distribution describes the service times. The mean service rate is one customer per minute. 
For economic considerations, Burger Dome evaluates customer waiting time at $10 per hour while the 
service channel can be operated for $7 per hour.

Management is interested in developing a better understanding of the operating characteristics of 
the food-service waiting line. Specifically, management would like to know the probability that no 
customers are in the system, the average number of customers waiting for service, the average time a 
customer waits for service, the probability that an arriving customer has to wait, and the hourly cost of 
the service operation.

10.3  CREATING AND SOLVING A PROBLEM

To solve the Burger Dome waiting line problem, we begin by selecting the Waiting Lines module and 
choosing New from the File menu; the Waiting Lines dialog box shown in Figure 
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10.1 will then appear. This dialog box can be used to select any one of the five waiting line models listed. 
Since the Burger Dome problem has a waiting line with Poisson arrivals and exponential service times, 
we select the Poisson Arrivals/Exponential Service model. The Poisson Arrivals/Exponential Service 
dialog box shown in Figure 10.2 appears on the screen. The data for the Burger Dome problem are 
entered with Number of Channels = 1, Mean Arrival Rate = .75, and Mean Service Rate = 1. Economic 
Analysis appears as a question since the waiting line model can be implemented with or without an 
economic analysis. Since the Burger Dome problem requested an economic analysis, the Economic 
Analysis box has been clicked on and the customer waiting time of $10 per hour and service channel cost 
of $7 per hour have been entered.

Figure 10.1  Waiting Lines Dialog Box

Figure 10.2  Poisson Arrivals/Exponential Service Dialog Box
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After the data input process is completed, Solve or Save can be implemented by selecting the 
appropriate button in the data input dialog box. Selecting Solve provides the output shown in Figure 
10.3. While no direct recommendation is made, the output provides valuable information about the 
operating characteristics of the waiting line. An average of 2.25 customers are in the waiting line, the 
customers wait an average of three minutes for service, and .75 or 75% of the arriving customers have to 
wait for service. The total cost is $37.00 per hour. In addition, the probabilities of the number of 
customers in the system show that some long waiting lines are possible. The information in Figure 10.3 
indicates that something should be done to improve the operation of the Burger Dome service facility.

Figure 10.3  Output for the Burger Dome Waiting Line Problem

Using the Edit menu, we can easily display the data input dialog box again and change the number 
of channels from 1 to 2. Selecting Solve shows the improved operating characteristics for the expanded 
Burger Dome service operation. The total cost of the two-channel system is $22.73 per hour. Repeating 
the edit process shows that the addition of a third channel with the total cost increasing to $28.65 per 
hour is not necessary.

10.4  OTHER CONSIDERATIONS
Each of the five models in the Waiting Lines module requires the input data to be based on the same 
period of time. The user may select the most convenient period of time such as a 
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minute, hour, day, and so on. However, once selected, all input data must be stated in terms of the 
selected period of time. The output information will appear in terms of the selected time period. For 
example, if the user selects an hourly period of time, a mean arrival rate of 45 customers per hour and a 
mean service rate of 60 customers per hour will result in hourly output waiting times. On the other hand, 
if the user wanted to use a minute as the time period, the mean arrival rate would be converted to 45/60 
= 0.75 customers per minute and the mean service rate would be converted to 60/60 = 1 customer per 
minute; in this case the output waiting times will be in minutes.

Model 2 allows the user to specify any arbitrary service time and requires care to ensure that 
proper units are maintained during the data input process. The data input requires the mean arrival 
rate, the mean service rate, and the standard deviation of service times to be stated in terms of the same 
period of time. For example, assume that data for a particular application have a mean arrival rate of 
two units per hour, service times with a mean of 20 minutes, and a standard deviation of 12 minutes. 
Assume that an hour is the time period selected by the user. The mean arrival rate is the stated two units 
per hour. However, on an hourly basis the mean service rate is 60/20 = 3 units per hour. The standard 
deviation, which is input directly as time, must be converted to the same hourly basis. Thus the standard 
deviation of service times would be 12/60 = 0.20 hour. If all the input is not stated 
in terms of the same unit of time, the module will provide incorrect and misleading output information.
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CHAPTER 11

DECISION ANALYSIS

Decision analysis can be used to help a decision maker select the best decision alternative for problems 
involving several decision alternatives and an uncertain or risk-filled pattern of future events. A 
complicating factor in selecting the best alternative is that the future chance events, are uncontrollable; 
thus, the decision maker must select a decision alternative before knowing which chance outcome will 
occur.

The following three steps can be used to structure a decision analysis problem:

1. Identify the decision alternatives

2. Identify the chance event and the states of nature (outcomes) for the chance event

3. Identify the payoff associated with each decision alternative and each state of nature (chance 
event outcome) combination

The above information can be summarized in a payoff table; the decision alternatives correspond to the 
rows of the table, the states of nature correspond to the columns of the table, and the payoffs are the 
values in each row and column.

The decision analysis approach to selecting the best decision alternative depends on whether or 
not probabilities are specified for the states of nature. If probabilities for the states of nature are not 
specified, the decision maker first selects one of several decision criteria; then, a decision alternative is 
recommended based on the criteria preference of the decision maker.

If probabilities for the states of nature are specified, decision analysis can be used to provide the 
following information:

1. The expected value or long-run average payoff for each decision alternative

2. A recommended decision alternative based on the best expected value

3. Expected value of perfect information—the expected value if the decision maker has the perfect 
information (i.e., the decision maker knows in advance which state of nature will occur)

In addition, decision analysis with probabilities provides the option of using sample  (indicator) 
information to revise the probabilities of the states of nature. In many cases a decision strategy based on 
the sample information can provide a better expected value.
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11.1  OVERVIEW

The Decision Analysis module of The Management Scientist is designed to provide a recommended 
decision alternative for problems having the following characteristics:

1. Up to 10 decision alternatives

2. Up to 10 states of nature

3. Known or unknown state of nature probabilities

A variety of measures such as profit, cost, time, utility, and so on may be used for the payoff.
For decision making without probabilities, the decision maker has the choice of three decision 

criteria: optimistic, conservative, and minimax regret. The module will provide a recommended decision 
based on the criterion selected.

For decision making with probabilities, the module will provide a recommended decision based on 
the expected value criterion. Information is also provided for the expected value of perfect information.

When probabilities are used, an option is also provided for developing a decision strategy based 
on sample (indicator) information. In this situation, sample information will guide the decision maker in 
selecting the best decision alternative. The module will identify the optimal decision strategy, its 
expected value, the expected value of the sample information, and the efficiency of the sample 
information.

11.2  AN EXAMPLE PROBLEM

Political Systems, Inc., (PSI) is a computer service firm specializing in information services such as 
surveys and data analysis for individuals running for political office. PSI is in the final stages of 
selecting a computer system for its Midwest office. The three decision alternatives PSI is considering are 
as follows:

d1 = a large computer system 

d2 = a medium-sized computer system 

d3 = a small computer system

The uncertainty of the customer acceptance of the PSI service is the chance event. It makes it 
difficult to know for sure which computer system the company should select. The following two states of 
nature for the chance event have been identified:

s1 = high customer acceptance of the PSI services

s2 = low customer acceptance of the PSI services

For now, assume that probability information is not available for the states of nature.
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The payoff table showing the projected profit for each decision alternative and each state of nature 
combination is shown in Table 11.1. Given this information, which computer system should PSI select?

States of Nature
Decision Alternatives High Acceptance Low Acceptance

Large Computer System 200,000 –20,000
Medium-Sized Computer System 150,000 20,000
Small Computer System 100,000 60,000

Table 11.1  Payoff Table for the PSI Problem

11.3  CREATING AND SOLVING A PROBLEM

To solve the PSI decision analysis problem, we begin by selecting the Decision Analysis module and 
choosing New from the File menu; the Problem Features dialog box will then appear. Figure 11.1 shows 
this dialog box after entering 3 for the Number of Decision Alternatives and 2 for the Number of States 
of Nature. For now, we will leave the State of Nature Probabilities turned off and analyze the PSI 
problem without using probability information. In Section 11.4 we will discuss the PSI problem when 
probability information is used.

Figure 11.1  Problem Features Dialog Box

After selecting OK in the Problem Features dialog box of Figure 11.1, we obtain the Payoff Table 
data input screen shown in Figure 11.2. Payoff data from Table 11.1 are entered into the corresponding 
cells of the Payoff Table as shown in Figure 11.2. When the payoff data input process is completed, 
choosing Solve from the Solution menu provides the 
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Select Optimization/Decision Criteria dialog box shown in Figure 11.3. For the PSI problem, we 
selected maximize the payoff as the optimization procedure and optimistic as the decision criterion. 
Selecting OK provides the output shown in Figure 11.4. The optimistic criterion recommends decision 
alternative 1, the large computer system.

Figure 11.2  Data Input Screen for the PSI Problem

Figure 11.3  Select Optimization/Decision Criteria Dialog Box
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Figure 11.4  Output Information for the PSI Problem Using the Optimistic Criterion

11.4  USING PROBABILITY INFORMATION

Let us assume that state of nature probabilities are available for the PSI problem with the probability of 
high customer acceptance (state of nature 1) 0.3 and the probability of low customer acceptance (state of 
nature 2) 0.7. Decision analysis uses the probability information and the expected value criterion to 
make a decision recommendation.

With probability information available, The Management Scientist will consider this a new 
problem. Use the File menu and select New to obtain the Problem Features dialog box as shown in 
Figure 11.1. This time click the State of Nature Probabilities box. Selecting OK provides the Payoff 
Table data input screen shown in Figure 11.2 along with two additional cells used to enter the two state 
of nature probabilities. When the data input process is completed, choosing Solve from the Solution 
menu provides the Select Optimization Criteria dialog box, which enables the selection of a maximize or 
minimize criterion. Selecting maximize and then selecting OK provides the output shown in Figure 11.5. 
In this case, decision alternative 3, the small computer system, is recommended. The expected value is 
$72,000. It is also shown that the expected value of perfect information is 30,000.
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Figure 11.5  Output Information for the PSI Problem Using the Expected Value Criterion

Sample Information and a Decision Strategy

If you are using state of nature probabilities, you will be given the option of selecting whether or not you 
would like to use sample information to develop a decision strategy. Let us return to the PSI problem and 
assume that a marketing research study will be undertaken in order to obtain sample information about 
possible customer acceptance of the PSI service. The study is referred to as an indicator, and the results 
of the study are referred to as indicator (or sample) outcomes. The two indicator outcomes for the PSI 
problem are as follows:

I1 = favorable market research report (individuals contacted generally express considerable 
interest in PSI’s services)

I2 = unfavorable market research report (individuals contacted generally express little interest in 
PSI’s services)

In general, the use of sample information requires the identification of two or more indicator 
outcomes. In addition to specifying the indicator outcomes, we must also have information about the 
conditional probability of each indicator outcome for each state of nature. The conditional probability 
information for the PSI problem is shown in Table 
11.2. For example, given state of nature 1 were to occur, there is a 0.8 probability the 
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indicator outcome will be favorable and a 0.2 probability the indicator outcome will be 
unfavorable.

Indicator Outcome
States of Nature Favorable (I1) Unfavorable (I2)

High acceptance (s1) 0.8 0.2
Low acceptance (s2) 0.1 0.9

Table 11.2  Conditional Probabilities of Indicator Outcomes for Each State of Nature

Let us now consider how the decision analysis module can be used to develop an optimal decision 
strategy based on the results of the market research indicator outcomes. In addition, we will determine 
the expected value of the sample information provided by the market research study.

When a decision analysis problem requires the computation of a decision strategy, the Problem 
Features dialog box appears as shown in Figure 11.6. Note that both State of Nature Probabilities and 
Compute Decision Strategy have been clicked on. The values shown for the number of decision alterna-
tives, number of states of nature, and number of indicator outcomes are for the PSI decision strategy 
problem.

Figure 11.6  Problem Features Dialog Box for the PSI Decision Strategy Problem

Clicking OK provides the Payoff Table data input screen shown in Figure 11.7. The top part of the 
screen provides the payoff table input as before. The sections labeled Enter State of Nature Probabilities 
and Indicator Probabilities are used to input the state of nature probabilities and the indicator 
probabilities from Table 11.2. When the data input process is completed, choosing Solve from the 
Solution menu provides the Select Optimization Criteria dialog box, which enables the selection of a 
maximize or minimize criterion. Selecting maximize and then clicking OK provides the output shown in 
Figure 11.8 on page 68. The 
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optimal decision strategy shows decision alternative d1 (large computer system) if the indicator outcome 
is I1 (favorable market research report), and decision alternative d3 (small computer system) if the 
indicator outcome is I2 (unfavorable market research report).

Figure 11.7  Data Input Screen for the PSI Decision Strategy Problem
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Figure 11.8  Optimal Decision Strategy for PSI

Additional output information shows that if indicator outcome I1 occurs the expected profit will be 
$150,322.58. The probability of this indicator outcome is 0.31. Also note that if indicator outcome I2 
occurs, the expected profit will be $63,478.26. The probability of this indicator outcome is 0.69. The 
expected value of the decision strategy using the indicator outcome information is $90,400. Thus the 
expected value of the market research sample information is $18,400. The value of sample information is 
61.3% of the value that could be obtained with perfect information.
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CHAPTER 12

FORECASTING

A critical aspect of managing any organization is planning for the future. Indeed, the long-run success of 
an organization is closely related to how well management is able to foresee the future and develop 
appropriate strategies. Forecasting techniques are available to help managers predict many future 
aspects of a business operation.

Historical data on quantities such as sales, demand, stock prices, university enrollments, and so on 
are collected over time and form what are called time series. Specifically, a time series is a set of 
observations measured at successive points in time or over successive periods of time. The manager who 
wishes to forecast a particular time series will find that the historical values of the time series provide 
clues about future values.

Quantitative forecasting methods are based on an analysis of historical data. When the historical 
data used is restricted to past values in the time series being forecasted, the forecasting procedure is 
called a time series method.

12.1  OVERVIEW

The Forecasting module of The Management Scientist will compute forecasts for a time series with up to 
100 data values (observations) using the following methods:

1. Moving Averages—This method uses the average of the most recent data values to forecast the 
next value for the time series. The number of data values in the moving average forecast must be 
specified by the user.

2. Exponential Smoothing—This method uses a combination of the forecast for the most recent 
period and the actual time series value for the most recent period to forecast the next value for 
the time series. The weight used for the most recent time series value is referred to as the 
smoothing constant and must be specified by the user.

3. Trend Projection—This method uses the least squares method to develop a linear trend 
equation, which expresses the time series values as a linear function of the time period. 
Forecasts are made by evaluating the linear trend equation for future time periods.

4. Trend and Seasonal Components—This method applies to a time series that has both trend and 
seasonality. First the seasonal influence is removed from the time series by a process referred to 
as deseasonalizing the data. Then the least squares method is used to develop a linear trend 
equation, which expresses the deseasonalized time 
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series as a linear function of the time period. The linear trend equation is used to forecast future 
values for the deseasonalized time series. Finally, an adjustment for the seasonality of the time 
period provides the forecast for the time series.

A given time series may be analyzed by one or more of the above forecasting methods. A 
comparison of forecasting accuracy for the methods will indicate which method appears to have the best 
potential for forecasting future values of the time series.

12.2  AN EXAMPLE PROBLEM

Consider the 12 weeks of data presented in Table 12.1. These data provide a time series of the number of 
gallons of gasoline sold by a gasoline distributor in Bennington, Vermont, over the past 12 weeks. Use 
the method of moving averages to forecast the number of gallons of gasoline that will be sold in week 13.

Sales
Week (1000s of Gallons)

1 17
2 21
3 19
4 23
5 18
6 16
7 20
8 18
9 22

10 20
11 15
12 22

Table 12.1  A Time Series of Gasoline Sales

12.3  CREATING AND SOLVING A PROBLEM

To forecast the number of gallons of gasoline that will be sold in week 13 for the time series shown in 
Table 12.1, we begin by selecting the Forecasting module and choosing New from the File menu. When 
the Time Periods dialog box appears, enter 12 for the Number of Time Periods and choose OK; these 
steps result in the data input screen. Figure 12.1 shows the data input screen after entering the gasoline 
sales time series data. After selecting Solve from the Solution menu, we obtain the Forecasting Methods 
dialog box shown in Figure 12.2. Any one of the four methods listed may be used to forecast values for 
the time series.



72

Moving Averages

Moving averages appears as choice 1 in the Forecasting Methods dialog box in Figure 12.2. This 
method is automatically selected each time the Forecasting Methods dialog box appears.

Figure 12.1  Data Input Screen for the Gasoline Sales Time Series

Figure 12.2  Forecasting Methods Dialog Box
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To use the Moving Averages method to forecast gasoline sales, you must enter the Number of 
Periods to be included in the moving average. Any number of periods from 1 to the number of periods in 
the time series (12 in this example) may be used in the moving average. In order to continue this 
example, we used 3 as the number of periods to be included in the moving average.

After you specify the number of periods for the moving average and click Solve, the Forecasting 
module provides a summary of the three-week moving average calculations for the gasoline time series; 
Figure 12.3 shows the output provided. The time series values, the moving averages forecasts, and the 
forecast errors are shown for the entire time series. Since an important consideration in using any fore-
casting method is the accuracy of the forecasts, the mean square error (MSE), a measure of the accuracy 
of the forecasting method, is also provided. Also shown is the forecast for the next period in the time 
series. Thus, we see that the three-period moving averages forecast for week 13 is 19,000 gallons.

Figure 12.3  The Forecasting Error and Forecast for the 3-Week Moving Averages

Exponential Smoothing

Exponential smoothing appears as choice 2 in the Forecasting Methods dialog box in Figure 12.2. This 
method uses a combination of the forecast for the most recent period and the actual time series value for 
the most recent period to forecast the next value for the time series. The weight used for the most recent 
time series value is referred to as the smoothing 
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constant. If you select the exponential smoothing method, you will be asked to enter the value of the 
smoothing constant. This value must be between 0 and 1.

Output information includes the time series values, the exponential smoothing forecast, and the 
forecast errors for the historical time series. In addition, the mean square error and the forecast for the 
next time period are also provided.

Trend Projection

Trend projection appears as choice 3 in the Forecasting Methods dialog box shown in Figure 12.2. This 
method uses the criterion of least squares to develop a linear trend equation, which expresses the time 
series values as a linear function of the time period. The trend projection analysis begins as soon as this 
option is selected. No additional input information is required.

The output information will provide a linear trend equation in the form

T = b0 + b1t

where
t = the time period

T = the trend value of the time series in period t

b0 = the intercept of the trend line

b1 = the slope of the trend line

The numerical values of b0 and b1 will be provided as part of the output. Additional output information is 
similar to the output provided by the moving averages and exponential smoothing routines.

Trend and Seasonal Components

Forecasting with trend and seasonal components appears as choice 4 in the Forecasting Methods dialog 
box shown in Figure 12.2. This method should be used for time series that are believed to have both 
linear trend and seasonality. If you select this forecasting method you will be asked to enter the number 
of seasonal indexes to be computed. In order to do this you must have an idea of how many seasons are 
present in the time series. The forecasting method will develop a seasonal index for each season present. 
If you have a time series with monthly data for several years, you will probably request 12 seasonal 
indexes to consider the possibility that each month has a different seasonal effect. If you have a time 
series with quarterly data for several years, you will probably request 4 seasonal indexes to consider the 
possibility that each quarter has a different seasonal effect.

After you enter the number of seasonal indexes, the output will appear on the screen in three 
separate sections. The first section will provide the seasonal indexes. Figure 12.4 shows an example of 
this output for a time series with quarterly data. The fourth quarter with an index of 1.141 shows that the 
time series is 114.1% higher in this quarter when the seasonal influence is considered. The second 
quarter with an index of 0.836 shows that the time series will tend to be lower than normal in this 
quarter. The other output sections follow the format of Figure 12.3; that is, the past time series values, 
the forecasts, the forecast 
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errors, the mean square error, and the forecasts for each of the next three time periods are provided, as 
well as an option of forecasting additional periods in the future. Simply request this option, enter the 
time period you wish to forecast, and the Forecasting module will provide the forecast.

FORECASTING WITH TREND AND SEASONAL COMPONENTS

SEASON SEASONAL INDEX

1 0.931

2 0.836

3 1.092

4 1.141

Figure 12.4  An Example with Four Seasonal Indexes



76

CHAPTER 13

MARKOV PROCESSES

The analysis of brand loyalty and brand switching behavior is one of the major applications of Markov 
processes. In this application, the purchase decision that is made each time period by a customer 
involves selecting one of several competing brands. The brands are referred to as the states of the 
process. Given that the customer has purchased a specific brand during the current time period, 
transition probabilities describe the probabilities that the customer will purchase the same brand as well 
as each of the competing brands during the following time period.

The transition probability for a given state to itself is a measure of brand loyalty in that it indicates 
the probability that the customer will purchase the same brand in two successive periods. The transition 
probabilities for a given state to each of the other states measure the brand switching behaviors of the 
customer. Based on known or assumed transition probabilities, a Markov process model can be used to 
answer questions such as the following:

1. In the long run, what market share will each brand have?

2. If a new and/or improved brand enters the market, what impact can be expected on the market 
share of each brand?

3. For a given group of customers, how many will purchase each brand each time period?

Markov process models have also been developed for machine break down behavior, estimating 
allowances for bad debt, and university enrollment projections. In each instance it is assumed that (1) 
there are a finite number of states, (2) the transition probabilities remain constant over time, and (3) the 
probability of being in a particular state at any one time period depends only on the state of the process 
during the preceding time period.

13.1  OVERVIEW

The Markov processes module of The Management Scientist will analyze problems with up to 10 states. 
Input to the program is the matrix of transition probabilities for the states. The solution provides the 
steady-state probabilities for the states.

In some applications it may not be possible to make a transition out of one or more states once the 
state has been reached. Such states are referred to as absorbing states. The Markov processes module 
will solve problems for which the total number of absorbing and nonabsorbing states is 10 or less. In 
applications with absorbing states, the solution provides 
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the probability that units currently in each of the nonabsorbing states will eventually end up in each of 
the absorbing states.

13.2  AN EXAMPLE PROBLEM

Two grocery stores in a small town compete for customers. Each customer makes one shopping trip per 
week to one of the two stores. A survey of store loyalty among the customers shows that for customers 
who shop at Murphy’s Foodliner one week, 90% will shop at Murphy’s the next week and 10% will 
switch to Ashley’s Supermarket. For customers who shop at Ashley’s Supermarket one week, 20% will 
switch to Murphy’s the next week and 80% will shop again at Ashley’s. These transition probabilities are 
summarized as follows:

Current Weekly Next Weekly Shopping Period
Shopping Period Murphy’s Foodliner Ashley’s Supermarket

Murphy’s Foodliner 0.9 0.1

Ashley’s Supermarket 0.2 0.8

What are the steady-state probabilities for the two grocery stores? If there are 1,000 customers that 
make weekly shopping trips to one of the two stores, how many customers can be expected to shop at 
each of the stores?

13.3  CREATING AND SOLVING A PROBLEM

To determine the steady-state probabilities for the two grocery stores in our example problem, we begin 
by selecting the Markov processes module and choosing New from the File menu. When the Markov 
Processes dialog box appears, enter 2 for the Number of States and choose OK; the Transition Matrix 
data input screen will then appear. Figure 13.1 shows the Transition Matrix after entering the transition 
probabilities for the grocery store example problem. After selecting Solve from the Solution menu, we 
obtain the output shown in Figure 13.2.
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Figure 13.1  Transition Matrix Data Input Screen

As you can see, Murphy’s Foodliner (state 1) has the higher steady-state probability. Thus, we 
conclude that in the long run, Murphy’s Foodliner will have a 66.7% share of the market and Ashley’s 
Supermarket will have the remaining 33.3% share of the market. With 1,000 weekly customers, 667 
should shop at Murphy’s and 333 should shop at Ashley’s.
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Figure 13.2  Output for the Grocery Store Market Share Problem

13.4  AN EXAMPLE PROBLEM 
WITH ABSORBING STATES

Heidman’s Department Stores has two aging categories for its accounts receivable: (1) accounts that 
are classified as 0 to 30 days old and (2) accounts that are classified as 31 to 90 days old. If any portion 
of an account balance exceeds 90 days, that portion is written off as a bad debt. The total account 
balance for each customer is placed in the age category corresponding to the oldest unpaid amount; 
hence, this method of aging accounts receivable is called the total balance method.

Let us assume that Heidman’s shows a total of $3,000 in its accounts receivable and the firm’s 
management would like an estimate of how much of the $3,000 will eventually be collected and how 
much will result in bad debts.

To see how we can view the accounts receivable operation as a Markov process, consider what 
happens to one dollar currently in accounts receivable.  As the firm continues to operate into the future, 
we can consider each week as a trial of a Markov process with a dollar existing in one of the following 
states of the system:
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State Description
1 Paid category
2 Bad debt category
3 0 to 30 days age category
4 31 to 90 days age category

Based on historical transitions of accounts receivable dollars, the following transition probabilities were 
developed for Heidman’s Department Stores:

To State
From State 1 2 3 4

1 1.0 0.0 0.0 0.0
2 0.0 1.0 0.0 0.0
3 0.4 0.0 0.3 0.3
4 0.4 0.2 0.3 0.1

The fact that the transition probabilities from state 1 to state 1 and from state 2 to state 2 are both 1 
shows that these two states are absorbing states. That is, once a dollar is paid (state 1) it is always paid. 
Similarly, once a dollar is declared a bad debt (state 2), it remains a bad debt. This leads us to conclude 
that all accounts receivable dollars will eventually be absorbed into either the paid or the bad debt state, 
and hence the name absorbing state.

The problem creation step for this problem is the same as that described previously. No special 
input procedures are required to handle the absorbing states. The output is shown in Figure 13.3. There 
is a .889 probability that the 0 to 30 day age category dollars will be paid and a .741 probability that the 
31 to 90 day age category dollars will be paid. 
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Figure 13.3  Output for the Accounts Receivable Problem
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